Lab 1: Introduction to R and RStudio
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You can download the lab here.
[bookmark: purpose]Purpose
The purpose of today’s lab is to start building and strengthening foundational coding skills in R. In labs, we take a functional and active approach to learning R. We believe that the easiest way to learn R is by using R. Giving you some building blocks and suggesting some strategies for overcoming common coding obstacles will allow you to begin exploring the language. In lab, you never need to actively memorize code chunks or functions. You will become proficient naturally with many hours of practice. Rather, the goal of lab is to expose you to what R can do so that you know what tools you have at your disposal when you are later working through a problem.
Today’s lab will cover:
1. How to download and install R and RStudio
1. The panes of RStudio
1. How to create and use R Markdown Documents
1. Arithmetic commands
1. (Some of) the different types of variables in R
1. What functions are and how to use them
1. How to install and load packages and…
1. How to import data into R
After we have covered the content of the lab, we will move on to Minihacks. Minihacks are small coding exercises intended to test your knowledge of the day’s material. The minihacks will be similar to—but narrower in focus than—the questions on your homework assignments. If you are able to successfully complete all of the minihacks, you should be well equipped to begin tackling your homework!

[bookmark: gs]Getting Started
So what is R?
In the simplest possible terms, R is a programming language used for conducting analyses and producing graphics. It is substantially more flexible than GUI-based statistics programs (e.g., SPSS, LISREL) but less flexible than other programming languages. This lack of flexibility is on purpose; it allows the code to be written in a far more efficient and intuitive way than other programming languages.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/other/lab1_flow.png]
Only one piece of software is required to get started using the R programming language and, confusingly, it is also called R. I will refer to it here as the R Engine. The R Engine essentially allows the computer to understand the R programming language, turning your lines of text into computer operations. Unlike other popular statistics programs (e.g., SPSS, SAS), the R Engine is free. Instructions for downloading the R Engine are below.
A second piece of software that is not required to use R but is nonetheless useful is RStudio. RStudio is an integrated development environment (IDE) or, in potentially overly simplistic terms, a tool that makes interacting with the R Engine easier. Instructions for downloading RStudio are also below.
[bookmark: download_r]Downloading the R Engine
1. Navigate to the webpage for the Comprehensive R Archive Network (commonly referred to as CRAN).
1. Under “Download and Install R” click the appropriate link for your operating system. For example, if you are using a Mac, you would click on Download R for (Mac) OS X.
1. Click the link for the latest release. As of writing this (September, 2021), the newest version is R 4.1.1. "Kick Things" (all version nicknames are references to the Peanuts comic strip). I would click R-4.1.1.pkg to start the download.
1. Once the file is downloaded, click on it to open it. Your operating system should guide you through the rest of the installation process.
Note. The same steps are used to update the R Engine: You install a new version and replace the old version in the process.
[bookmark: download_rstudio]Downloading RStudio
1. Navigate to the webpage for the free version of RStudio. For our purposes (and for most people’s purposes) the free version of RStudio is all that you need. The available installers are listed at the bottom of the page under the header “Installers for Supported Platforms.”
1. Select the installer for your operating system. Since I am using a macOS, I would click RStudio-1.4.1717.dmg. If you are using Windows 10, you would click RStudio-1.4.1717.exe.
1. Once the file is downloaded, click on it to open it. Your operating system should guide you through the rest of the installation process.
Note. To update RStudio after it is already installed, all you have to do is navigate to Help > Check for Updates in the menubar.

[bookmark: rstudio]Features of RStudio
As shown in the image below, an RStudio session is split into four sections called panes: the console, the source pane, the environment/history pane, and the succinctly named files/plots/packages/help pane.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/rstudio/lab1_rstudio_4panel.jpg]
[bookmark: rstudio_console]The Console
In RStudio, the console is the access point to the underlying R Engine. It evaluates the code you provide it, including code called using the the source pane. You can pass commands to the R Engine by typing them in after the >.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/rstudio/lab1_rstudio_console.png]
[bookmark: rstudio_source]Source
The source pane shows you a collection of code called a script. In R, we primarily work with R Script files (files ending in .R) or R Markdown documents (files ending in .Rmd). In this class, we will mostly be working with R Markdown files. The document you are currently reading was created with an R Markdown document.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/rstudio/lab1_rstudio_source.png]
[bookmark: rstudio_environment]Environment/History
The environment/history pane shows, well, your environment and history. Specifically, if you have the “Environment” tab selected, you will see a list of all the variables that exist in your global environment. If you have the “History” tab selected, you will see previous commands that were passed to the R Engine.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/rstudio/lab1_rstudio_environment.png]
[bookmark: rstudio_files]Files/Plots/Packages/Help
The final pane—the files/plots/packages/help pane–includes a number of helpful tabs. The “Files” tab shows you the files in your current working directory, the “Plots” tab shows you a preview of any plots you have created, the “Packages” tab shows you a list of the packages currently installed on your computer, and the “Help” tab is where help documentation will appear. We will discuss packages and help documentation later in this lab.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/rstudio/lab1_rstudio_files.png]

[bookmark: projects]Projects
Whenever you start a new research project, you should create a new R Project. The R project is a working directory where your .RProj file, scripts, data, images, etc. will live. Creating a folder that contains all of the files for your new research project will keep you organized and make it easy for others to download and reproduce your work. We will open up a new project for this class and call it psy611.
[bookmark: create_project]Creating a new project
1. In order to create a new project in RStudio, click on the R icon with the plus sign in the top left corner of RStudio.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/new_project/new_project.png]
1. Click on New Directory -> New Project. Name your new directory psy611 and store it somewhere on your computer using the Browse button. I would recommend storing it on your desktop.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/new_project/new_project2.JPG]
[bookmark: adding-folders-to-a-project]Adding folders to a project
1. Once you have a new directory, you can add folders to it. I recommend adding a folder for labs and a folder for homeworks since you will need RStudio for both. You can add a folder by clicking on New Folder in the files/plots/packages/help pane.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/new_project/new_folder.png]
1. You can nest folders within folders. For example, inside the labs folder, I want to create two more folders: a scripts folder and a data folder.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/new_project/psy611_labs_folder.JPG]

[bookmark: rmarkdown]R Markdown
You will mostly be using R Markdown documents in this course. In fact, it is required that your homeworks be created using an R Markdown document. The following section will guide you the process of creating an R Markdown document.
[bookmark: creating-an-r-markdown-document]Creating an R Markdown Document
1. Click on the blank piece of paper with the plus sign over it in the upper left-hand corner of RStudio.
1. Click on R Markdown....
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/rmarkdown/lab1_menu_an.png]
1. Enter the title of document and your name. I have chosen to title the document lab1.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/rmarkdown/create_rmarkdown.JPG]
1. Save your RMarkdown document by clicking on File -> Save. You want to save it in your labs -> scripts folder in your psy611 project.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/rmarkdown/save_rmarkdown.JPG]
[bookmark: using-an-r-markdown-document]Using an R Markdown Document
The content of R Markdown documents can be split into two main types. I will call the first type simple text. Simple text will not be evaluated by the computer other than to be formatted according to markdown syntax. If you are answering a homework question or interpreting the results of an analysis, you will likely be using simple text.
Markdown syntax is used to format the simple text, such as italicizing words by enclosing them in asterisks (e.g., *this is italicized* becomes this is italicized) or bolding words by enclosing them in double-asterisks (e.g., **this is bold** becomes this is bold). For a quick rundown of what you can do with R Markdown formatting, I suggest you check out the Markdown section of the R Markdown Cheat Sheet.
In addition to simple text, R Markdown documents support blocks (also called chunks) of R code. In contrast to simple text, the R code chunks are evaluated by the computer. The chunks are surrounded by ```{r} and ```. In the example image below, the 1 + 2 in the R Code chunk will be evaluated when the document is “knitted” (rendered). For your homeworks, you will want to include your analyses in these chunks.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/rmarkdown/lab1_raw.png]
[bookmark: knitting-an-r-markdown-document]Knitting an R Markdown Document
In order to knit an R Markdown document, you can either use the shortcut command + shift + k or click the button at the top of the R Markdown document that says Knit. The computer will take several seconds (or, depending on the length of the R Markdown document, several minutes) to knit the document. Once the computer has finished knitting the document, a new document will appear in the same location that the R Markdown document is saved. In this example, the new document will end with a .html extension.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/rmarkdown/lab1_knit.png]
As shown in the above image, the simple text in the R Markdown document on the left was rendered into a formatted in the knitted document on the right. The equation in the code chunk was also evaluated in the knitted document, returning the value 3.

[bookmark: the-basics-of-coding-in-r]The Basics of Coding in R
[bookmark: ac]Arithmetic commands
As mentioned above, you can pass commands to the R-engine via the console. R has arithmetic commands for doing basic math operations, including addition (+), subtraction (-), multiplication (*), division (/), and exponentiation (^).
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/arithmetic/lab1_addition.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/arithmetic/lab1_subtraction.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/arithmetic/lab1_multiplication.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/arithmetic/lab1_division.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/arithmetic/lab1_exponentiation.png]
R will automatically follow the PEMDAS order of operations (BEDMAS if you are from Canada or New Zealand or India). Parentheses can be used to tell R what parts of the equation should be evaluated first. As shown below and as expected, (10 + 5) * 2 is not equivalent to 10 + 5 * 2.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/arithmetic/lab1_paren.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/arithmetic/lab1_noparen.png]
[bookmark: variables]Creating Variables
You can create variables using the assignment operator (<-). Whatever is on the left of the assignment operator is saved to name specified on the right of the assignment operator. I like to imagine that there is a box with a name on it and you are placing a value, inside of the box. For example, if we wanted to place 10 into a variable called my_number, we would write:
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/assignment/lab1_assign.png]
If we want to see what is stored in my_number, we can simply type my_number into the console and press enter. We are essentially asking the computer, “What’s in the box with my_number written on it?”
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/assignment/lab1_peek.png]
If we want to overwrite my_number with a new value, we simply assign a new value to my_number.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/assignment/lab1_reassign.png]
Looking at my_number again, we can see that it is now 20.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/assignment/lab1_peek2.png]
We can treat variables just like we would the underlying values. For example, we can add 5 to my_number by using +.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/assignment/lab1_var_add.png]
Keep in mind, the above operation does not save the result of my_number + 5 to my_number. To do that, we would have to assign the result of my_number + 5 to my_number.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/assignment/lab1_reassign_add.png]
If we want to remove a variable from our environment, we can use rm().
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/assignment/lab1_rm.png]
[bookmark: types-of-variables]Types of Variables
In R, there are four basic types of data: (1) logical values (also called booleans), which can either be TRUE or FALSE, (2) integer values, which can be any whole number (i.e.., a number without digits after the decimal place), (3) double values, which can be any number with digits before and after the decimal place, and (4) character values (also called strings), which are pieces of text enclosed in quotation marks (").
	Type
	Examples

	Logical/Boolean
	TRUE, FALSE

	Integer
	10L, -10L

	Double
	10.50, -10.50

	Character
	"Hello", "World"


[bookmark: vectors]Vectors
[bookmark: atomic-vectors]Atomic Vectors
A collection of values is called a vector. If they are all of the same type, we call them atomic vectors. In R, we use the c() command to concatenate (or combine) values into an atomic vector.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/vectors/lab1_vector.png]
Just as we did with the scalar values above, we can assign a vector to a variable.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/vectors/lab1_vec_assign.png]
To print out the entire vector, we simply type my_vector into the console.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/vectors/lab1_vec_print.png]
In order to select just one value from the vector, we use square brackets ([]). For example, if we wanted the third value from my_vector we would type my_vector[3]1.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/vectors/lab1_vec_index.png]
If we want to replace a specific value in a vector, we use the assignment operator (<-) in conjunction with the square brackets ([]).
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/vectors/lab1_vec_index_assign.png]
As with single-value objects we can perform arithmetic operations on vectors, but the behaviour is not identical. If the vectors are the same length, each value from one vector will be paired with a corresponding value from the other vector. See below for an example of this in action.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/vectors/lab1_vec_add.png]
If the vectors of different lengths, the shorter vector will be recycled (i.e., repeated) to be the same length as the longer vector.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/vectors/lab1_vec_recycle.png]
This also works when the longer vector is not a multiple of the shorter vector, but you will get the warning: longer object length is not a multiple of shorter object length.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/vectors/lab1_vec_recycle_odd.png]

[bookmark: foot_vector]1. Unlike most other coding languages (e.g., python), indices in R start at 1 instead of 0. For instance, if you want to select the first element of a vector, you would write my_vector[1] instead of my_vector[0]. A second difference to keep in mind is that the - is used in R to remove whichever value is in the spot indicated by the index value. Using vector[-2] on the vector c(10, 20, 30, 40, 50, 60) would return c(10, 30, 40, 50, 60) in R. In python, it would return 50.

[bookmark: lists]Lists
A vector that can accomodate more than one type of value (e.g., a double AND a character) is called a list. To create a list, we use list() instead of c(). If we wanted to create a vector with the values 5L, 10, "fifteen", and FALSE we would use list(5L, 10, "fifteen", FALSE).
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/vectors/lab1_lists.png]
Although lists are an incredibly powerful type of data structure, dealing with them can be quite frustrating (especially for beginning coders). Since you are unlikely to need to know the inner workings of lists for anything we will be doing in this course, I have chosen not to include much about them here. However, as you become a more advanced user, learning to leverage lists will allow you to write code that is far more efficient.
[bookmark: data-frames]Data Frames
In R you will mostly be working with data frames. A data frame is technically a list of atomic vectors. For our purposes, we can think of a data frame as a spread sheet with columns of variables and rows of observations.
Let’s look at a data frame that is automatically loaded when you open R, mtcars. Type mtcars to print out the data frame.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/dataframes/lab1_mtcars.png]
The data frame mtcars has a row for 32 cars featured in the 1974 Motor Trend magazine. There is a column for the car’s miles per gallon (mpg), number of cylinders (cyl), engine displacement (disp), horse power (hp), rear axle ratio (drat), weight in thousands of pounds (wt), quarter-mile time (qsec), engine shape (vs), transmission type (am), number of forward gears (gear), and number of carburetors (carb).
With data frames, you can extract a value by including [row, col] immediately after the object. For example, if we wanted to extract the number of gears in the Datsun 710 we could use mtcars[3, 10] to extract the value stored in the third row, tenth column.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/dataframes/lab1_extract.png]
Since the rows and columns have names, we can also be explicit and use the name of the row ("Datsun  710") and the name of the column ("gear") instead of the row and column indices.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/dataframes/lab1_extract_explicit.png]
We can also extract an entire column by dropping the index value for the row. Since you don’t specify a given row, the computer assumes you want all of the values in the column. For example, to extract all values stored in the gear column, we could use [, 10] or [, "gear"].
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/dataframes/lab1_col_extract.png]
To extract an entire row, we drop the column index. To extract all of the values associated with the Datsun 710, we would drop the column index (e.g., [3, ] or ["Datsun 710", ])
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/dataframes/lab1_row_extract.png]
You can also extract columns using $ followed by the column name without quotes.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/dataframes/lab1_col_dollar.png]
If we want to extract multiple columns (or multiple rows) we use vectors. For example, if we wanted the number of gears and carburetors in the Datsun 710 and the Duster 360 we would use [c("Datsun 710", "Duster 360"), c("gear", "carb")] or [c(3, 7), c(10:11)].
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/dataframes/lab1_extract_vector.png]
[bookmark: functions]Functions
Up to this point, we have been more-or-less directly telling R what we want it to do. This is great if we want to understand the processes that underlie R, but it can be incredibly time-consuming. Thankfully, we have functions. Functions are essentially pre-packaged snippets of code that take one or more pieces of input (called arguments) and return one or more pieces of output (called values). For example, length() is a function that takes a vector as its sole argument and returns the length of the vector as its sole value.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_length.png]
The function unique() also takes a vector as its primary argument, but—instead of returning the length of the vector as its value—it returns only the unique values of that vector.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_unique.png]
The mean() function and sd() function are two functions that you will end up using a lot. The former (mean()) takes a numeric vector and returns the average of the vector.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_mean.png]
The latter (sd()) also takes a numeric vector, but it returns the standard deviation of the vector instead.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_sd.png]
Although it is more conceptual, it is also useful to mention the typeof() function here. The function typeof() takes any object and tells you what type of variable it is.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_type_int.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_type_double.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_type_character.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_type_logical.png]
Using the suite of as.*() functions (e.g., as.numeric(), as.character(), as.logical(), as.integer()), we can likewise coerce objects to other types.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_as_num.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_as_char.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_as_logical.png][image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/functions/lab1_as_integer.png]
[bookmark: help-documentation]Help Documentation
Sometimes when working in R you will want to know more about a function. For example, you might want to know what arguments the function sd() takes. You can use ? at the beginning of any function call to display the help documentation for that function.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/help_documentation/lab1_help_call.png]
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/help_documentation/lab1_help_doc.png]
From the help documentation we can see that sd() takes two arguments: (1) An R object and (2) a logical value indicating whether NAs (unknown values) should be removed before the standard deviation is calculated.
Typically R will infer, based on the order of the arguments, what values correspond to which arguments. For example, since sd() expects that the argument x will be provided first and the argument na.rm will be provided second, the following works:
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/help_documentation/lab1_sd.png]
However, we can also explicitly tell R what values are associated with which arguments.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/help_documentation/lab1_sd_explicit.png]
The help documentation for a function often also includes an example of how to use the function and details on what the expected output will be.
[bookmark: googling-your-error-message]Googling your error message
You will come across many messages in your time using RStudio. Some messages are error messages and some are warning messages. If a message says warning message then R was able to run the code but not as it was intended. An error message means that R was not able to run the code at all. Here is an example of code that would produce a warning message.
mean(c(4,5,"6",7,5))
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/googling_error/error_message_3.JPG]
When you get a warning or error message, and you aren’t sure what it means, you should first try googling the message. Oftentimes, others have encountered your problem and have asked for help deciphering the message.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/googling_error/error_message.JPG]
Scott from Stack overflow suggests converting the character “6” into a numeric variable. Let’s try that.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/googling_error/error_message_2.JPG]
mean(c(4,5,as.numeric("6"),7,5))
## [1] 5.4
[bookmark: comments]Comments
Comments are pieces of code text that are not interpreted by the computer. In R we use the octothorpe/pound sign/hashtag (#) at the beginning of a line to denote a comment. The first and third line of code below are not evaluated, whereas the second and fourth line are.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/comments/lab1_comment.png]
Comments are mostly used to remind yourself (or other people) what a piece of code does and why the code is written the way that it is. Below is a piece of code that checks if a string is a valid phone number. We can see that the comments explain, not only what each piece of code is doing, but also why the second piece of code was written the way that it was.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/comments/lab1_validate.png]

[bookmark: packages]Packages
A package can include code, documentation for that code, and/or data. A helpful way to think of packages is as a toolbox full of data analysis tools.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/packages/psych_toolbox_2.png]
There are general purpose toolboxes that contain tools for running common analyses in psychology (e.g., {psych}), toolboxes for helping your run advanced statistical models (e.g., {lavaan}; {lmer}), toolboxes for text mining (e.g., {tidytext}), and toolboxes for plotting (e.g., {ggplot2}, {gganimate}). If you have a problem that needs to be solved, there will probably be a package for it.
[bookmark: installing-packages]Installing packages
To install a package onto your computer, you simply pass the name of the package to install.packages(). As a demonstration, we install the {psych} package below. The {psych} package has several useful data analysis tools for psychologists.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/packages/lab1_install.png]
Note. When installing packages, the package name must be enclosed in quotes: install.packages("psych") NOT install.packages(psych). You generally only need to install a package once.
[bookmark: loading-a-package]Loading a package
Just because we’ve installed a package to our computer doesn’t mean we have access to its functions. Buying a toolbox doesn’t necessarily give you access to its tools. You also have to open the toolbox. To open {psych} and load its functions, we use library().
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/packages/lab1_load.png]
Note. A package can be loaded with or without quotes: library("psych") OR library(psych). We have to load a package every time that R is restarted.
[bookmark: try-psych-commands]Try psych commands
Now that we have installed and loaded the {psych} package, let’s try out of some its commands.
Using corr.test() we can make a correlation matrix of the variables in mtcars.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/packages/lab1_corr_test.png]
Using skew(), we can look at the skew of all of the columns in mtcars.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/packages/lab1_skew.png]
We can also use t2d() to calculate the Cohen’s d for a t-value of 3.00 with 300 participants.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/packages/lab1_t2d.png]
This is only a small subset of the functions available in the {psych} package, and {psych} is only one package of over 18,262 on CRAN (as of 27th September, 2021). This is not to mention the tens of thousands of packages hosted on online repositories like GitHub.
[bookmark: data]Importing Data into R
The final topic that we will cover in this lab is how to load data into R. Over the course of your grad school careers (and many times in this class) you will need to import data into R to be analyzed.
For this example, we will be using the planets data set from Star Wars. The data can be downloaded here.
There used to be file-type-specific functions to load data into R (e.g., read.csv, read_excel) a few years ago. You might see these often if you are looking up solutions for your coding problems. The {rio} package streamlines this process by having a single import function (import()) that infers the file type from its extension (e.g., .csv, .xlsx, .sav). It also allows you to specify the class and format of your data when you import it; this feature very useful when you are trying to streamline your workflow. Additionally, the {here} package makes it very easy to reference folders in your directory.
As we did for {psych}, if you don’t have these packages already, you will first need to install {rio} and {here}. You can install {rio} and {here} with the following code: install.packages(c("rio", "here")).
Second, we will need to load {rio} and {here} using the library functions. Then, we will import the data by using the import function from the {rio} package and the here function from the {here} package. (If you are using a certain library only once, consider using the the :: for importing a function instead of loading the entire library). In order to use the here function, we need to know which folder my dataset is saved in. In this case, the sw_planets.xlsx is saved in labs -> data. Finally, we will save the data into a variable, planets_data.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/importing_data/rio_here.JPG]
To ensure it was read in properly, we can look at the first six rows of the imported dataset by using the head() function.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/importing_data/lab1_head.png]
We can also look at the last six rows by using the tail() function.
[image: /Users/maxwelldrascher/Desktop/psy611/labs/resources/lab1/importing_data/lab1_tail.png]

[bookmark: minihacks]Minihacks
Now that we have covered the lab material, we will move on to the Minihacks. If you have any questions, I would be happy to answer them!
[bookmark: minihack-1-r-markdown]Minihack 1: R Markdown
1. Create an R Markdown document called lab1_minihacks. Save it in your Lab -> scripts folder.
1. Try rendering your R Markdown document by clicking knit. If it doesn’t render correctly, try to figure out why it didn’t.
[bookmark: minihack-2-arithmetic-commands]Minihack 2: Arithmetic Commands
1. Use R to calculate  and assign the result to a variable called x.
1. Assign the numbers 10, 20, and 30 to a vector called y.
1. Before running any code, determine what you think adding x to y would result in. Then, using R, add x to y.
[bookmark: minihack-3-functions]Minihack 3: Functions
1. Assign the string "I AM NOT YELLING" to a variable called exclamation.
1. Use the function tolower() to convert every letter of exclamation to lower case. Assign the result to exclamation.
1. Use the capitalize() function from the Hmisc package to capitalize the first letter of exclamation.
[bookmark: minihack-4-help-documentation]Minihack 4: Help Documentation
1. I wanted to create a vector of 5 values between 10 and 50 using seq(), but the code I wrote is creating a vector of 9 values between 10 and 50. I believe it has something to do with the arguments I used, but I can’t remember how to access the help documention to check. Without changing the values (i.e., 10, 50, and 5), can you fix my code?
seq(from = 10, to = 50, by = 5)
## [1] 10 15 20 25 30 35 40 45 50
[bookmark: minihack-5-data-frames]Minihack 5: Data Frames
1. Download the Marvel character dataset to your computer. Put the data file in your labs -> data folder.
1. Import the data into R and assign it to a variable called marvel_data.
1. Ah! The value for the number of appearances of Spider-Man seems to be an error! It should be 4043 not 40430! Use square brackets ([]) to replace the erroneous value with the correct value (hint: The value is stored in the first row of the eighth column).
1. Using mean() and dollar sign notation (data$column), calculate the average number of appearances for all of the Marvel characters. Assign the result to a variable called mean_appearances.
1. Install and load the package ggplot2.
1. If you successfully completed the proceeding steps, you should be able to run the following code without producing an error. If you get an error, try to figure out why you are receiving the error.
ggplot(marvel_data, aes(x      = reorder(align, -appearances), 
                        y      = appearances,
                        fill   = align)) +
  geom_bar(stat = "summary", fun.y = "mean") +
  geom_point(shape    = 21,
             alpha    = .7,
             position = position_jitter(w = 0.4, h = 0)) +
  geom_hline(yintercept = mean_appearances,
             linetype   = "twodash",
             lwd        = 1,
             colour     = "firebrick") +
  annotate(geom   = "text", 
           x      = 3, 
           y      = 800, 
           size   = 5,
           label  = paste("Mean = ", round(mean_appearances, 2)),
           colour = "firebrick") +
  scale_fill_viridis_d() +
  theme_bw(base_size = 15) +
  theme(legend.position = "none") + 
  labs(title    = "Alignment and Appearances",
       subtitle = "Marvel character appearances by alignment",
       x        = "Alignment",
       y        = "Appearances")
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mean(c(10, 20, 30, 40, 50, 60))

## [1] 35
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sd(c(10, 20, 30, 40, 50, 60))

## [1] 18.70829
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typeof(10L)

## [1] "integer"
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typeof(10)

## [1] "double"
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typeof("hello™)

## [1] "character”
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typeof (TRUE)

## [1] "logical”
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as.numeric("10™)

## [1] 10
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as.character(10)

## [1] "10"
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as.logical(l)

## [1] TRUE
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as.integer(10.30)

## [1] 10
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Files Plots Packages Help Viewer -
@& D0
R: Standard Deviation ~  Find in Topic

sd {stats} R Documentation

Standard Deviation

Description

This function computes the standard deviation of the values in x. If na.rmis TRUE then missing values are
removed before computation proceeds.

Usage
sd(x, na.rm = FALSE)
Arguments

X a numeric vector or an R object but not a factor coercible to numeric by as.double(x).

na.rm logical. Should missing values be removed?

Details

Like var this uses denominator n - 1.

The standard deviation of a length-one or zero-length vector is NA.

See Also
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sd(c(10, 20, 30, 40, 50, 60), FALSE)

## [1] 18.70829




rId114.png
sd(x = c(10, 20, 30, 40, 50, 60), na.rm = FALSE)

## [1] 18.70829
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> mean(c(4,5,
[11 NA
warning message:
In mean.default(c(4, 5, "6", 7, 5))

argument is not numeric or logical: returning NA

6",7,5))
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‘About 22,100,000 results (0.48 seconds)

stackoverflow.com » questions » mean-warning-argum... ~

mean() warning: argument is not numeric or logical: returning ...

Oct 31,2013 - You could obtain the column means by using any of the following lapply(results,
mean, na.rm = TRUE) sapply(results, mean, na.rm = TRUE)

2 answers
R-argument is not numeric or logical: returning NA - Stack Sep3,2018
argument is not numeric o logical: returning NAin R- Stack .. Feb 4,2015
Argument is not numetic or logical: returning NA Table with ..~ Mar 3,2018

Argument is not numeric or logical: returning NA (calculating .. Oct 6,2016
More results from stackoverflow.com

discuss.analyticsvidhya.com > warning-argumentis-not... ~

Warning: argument is not numeric or logical: returning NA ...

Aug 12,2015 - badsis.na(z$Solar.R) mean(zltbad ) [1] NA Warning message: In mean.defauit(z
[tbad, ) : argument is not numeric or logical: returning NA.

WWW.programmingr.com » r-error-messages » fiing .. v

Fixing R Errors: argument is not numeric or logical: returning na

“This problem results from entering neither a numeric nor logical argument into the mean()
function. ... You get a mean of 0.6, this is because the mean() function sees “TRUE” and “FALSE"
as numeric values of 1and 0 respectively.

Tools
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@iogo chr *  -0.255" efcetcresult of str(pivot) — Ayubx Feb 1816 at1541 /
@ricola There is a warning NAs introduced by coercion ~ Ayubx Feb 1816 at 1548 /

1 @Ayubx Why you don't just post the output of dput(pivot) to let us see what it actually contains? Every
question should be reproducible, you won't receive any help if you don't provide the relevant information. —
nicola Feb 1916 at 7:48

show 4 more comments.

2 Answers Active | Oldest | Votes

FIND A JOB.
Jobs

Companies

4

TEAMS Whats his?

[} Free 30 Day Trial

@Ayubx The question @nicola is posing to you is how do you take the mean of characters? You
can't, so you need to convert the characters to numeric. The below is an example

> d < ("5
> str(d)
chr [1:2] "5" 7"

> & <- as.numeric(d)

> str(e)

num [1:2] 5 7

> mean(d)

[1] A

Warning message:

In mean.default(d) : argument is not numeric or logical: returning NA
> mean(e)

s

)

share follow answered Feb 1816 at 16:43
Scott
g 52
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#1 + 1
2 + 2

## [1] 4

#3 + 3
4 + 4

## [1] 8
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# assign the phone number
phone_number <- "(541)-346-4921"

# validate the phone number; I did not account for country codes because all of
# the numbers are either from the US or Canada

grepLC"M\C\NA{31\\D)*C 1-D"\\d{3}C [-)*\\d{4}$", phone_number)

## [1] TRUE
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install.packages("psych™)
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library(psych)
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corr.test(mtcars)

## Call:corr.test(x = mtcars)

## Correlation matrix

#i# mpg cyl disp hp drat wt gsec S am gear carb
## mpg 1.00 -0.85 -0.85 -0.78 ©0.68 -0.87 0.42 0.66 0.60 0.48 -0.55
## cyl -0.85 1.00 0.90 0.83 -0.70 0.78 -0.59 -0.81 -0.52 -0.49 0.53
## disp -0.85 ©0.90 1.00 0.79 -0.71 0.89 -0.43 -0.71 -0.59 -0.56 0.39
## hp -0.78 ©0.83 0.79 1.00 -0.45 0.66 -0.71 -0.72 -0.24 -0.13 0.75
## drat 0.68 -0.70 -0.71 -0.45 1.00 -0.71 0.09 0.44 0.71 0.70 -0.09
## wt -0.87 0.78 0.89 0.66 -0.71 1.00 -0.17 -0.55 -0.69 -0.58 0.43
## gqsec 0.42 -0.59 -0.43 -0.71 0.09 -0.17 1.00 0.74 -0.23 -0.21 -0.66
## vs 0.66 -0.81 -0.71 -0.72 0.44 -0.55 0.74 1.00 0.17 0.21 -0.57
## am 0.60 -0.52 -0.59 -0.24 0.71 -0.69 -0.23 0.17 1.00 0.79 0.06
## gear 0.48 -0.49 -0.56 -0.13 0.70 -0.58 -0.21 ©.21 0.79 1.00 0.27
## carb -0.55 ©.53 0.39 0.75 -0.09 0.43 -0.66 -0.57 0.06 0.27 1.00
## Sample Size

## [1] 32

## Probability values (Entries above the diagonal are adjusted for multiple tests.)
## mpg cyl disp hp drat wt gsec vs am gear carb
## mpg 0.00 © 0.00 0.00 0.00 0.00 0.22 0.00 0.01 0.10 0.02
## cyl 0.00 0 0.00 0.00 0.00 0.00 0.01 0.00 0.04 0.08 0.04
## disp 0.00 © 0.00 0.00 0.00 0.00 0.20 0.00 0.01 0.02 0.30
## hp ©0.00 0 0.00 0.00 0.17 0.00 0.00 0.00 1.00 1.00 0.00
## drat 0.00 0 0.00 0.01 0.00 0.00 1.00 0.19 0.00 0.00 1.00
## wt 0.00 0 0.00 0.00 0.00 0.00 1.00 0.02 0.00 0.01 0.20
## gqsec 0.02 © 0.01 0.00 0.62 0.34 0.00 0.00 1.00 1.00 0.00
## vs ©0.00 0 0.00 0.00 0.01 0.00 0.00 0.00 1.00 1.00 0.02
## an 0.00 © 0.00 0.18 0.00 0.00 0.21 0.36 0.00 0.00 1.00
## gear 0.01 0 0.00 0.49 0.00 0.00 0.24 0.26 0.00 0.00 1.00
## carb 0.00 0 0.03 0.00 0.62 0.01 0.00 0.00 0.75 0.13 0.00
#it

## To see confidence intervals of the correlations, print with the short=FALSE option
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skew(mtcars)

## [1] 0.6106550 -0.1746119 0.3816570 0.7260237 ©.2659039 0.4231465
## [7] 0.3690453 0.2402577 0.3640159 0.5288545 1.0508738
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t2d(t = 3.00, n = 300)

## [1] 0.3464102
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o - @ @S- HE e Go to file/function ~ Addins ~

@] labl.Rmd* =
Al B Q| @ Knit - - 3 - #Run ~ 4G, ~
1v ——-
2 title: "Labl"
3 author: "Vinita Vader"
4 date: "9/27/2021"
5 output: html_document
6 editor_options:
7 chunk_output_type: console
84 ——
9
10~ " {r} < D
11 #install.packages(c("rio","here"))
12 library(tidyverse)
13 1library(rio)
14 1libraryChere)
15 library(janitor)
le~
17
18~ " {r} < D
19 planets_data <- importChere("labs", "data", "sw_planets.xlsx"), setclass = "tb_df") %%
20 characterize() %>% #converts appropriate variables to character or factor
21 clean_names() #cleans up variable names and makes them accustomed to a tidy format
22~ "
23
21:87 Chunk 2 = R Markdown *
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head(planets_data)

##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##

name rotation_period orbital_period diameter climate

1 Alderaan 24 364 12500 temperate

2 Yavin IV 24 4818 10200 temperate, tropical

3 Hoth 23 549 7200 frozen

4 Dagobah 23 341 8900 murky

5 Bespin 12 5110 118000 temperate

6 Endor 18 402 4900 temperate
gravity terrain surface_water population

1 1.00 grasslands, mountains 0.40 2000000000

2 1.00 jungle, rainforests 0.08 1000

3 1.10 tundra, ice caves, mountain ranges 1.00 NA

4 NA swamp, jungles 0.08 NA

5 1.50 gas giant 0.00 6000000

6 0.85 forests, mountains, lakes 0.08 30000000
population_mils au g radius mass area

1 2000.000 ©.9981727 9.80 6250 5735809280080550912 122718463

2 0.001 5.5853358 9.80 5100 3819223023997316096 81712825

3 NA 1.3127630 10.78 3600 2093304245678805504 40715041

4 NA 0.9556694 NA 4450 NA 62211389

5 6.000 5.8087857 14.70 59000 766707920792079302656 10935884027

6 30.000 1.0664867 8.33 2450 749179287632153216 18857410
solar_system orig_tril

1 FALSE new_hope

2 FALSE <NA>

3 FALSE empire_strikes

4 FALSE empire_strikes

5 FALSE empire_strikes

6 FALSE return_jedi
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tail(planets_data)

##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##

56
57
58
59
60
61

56
57
58
59
60
61

56
57
58
59
60
61

56
57
58
59
60
61

name rotation_period orbital_period diameter

412
NA
378
NA
304
NA

climate gravity
1 plains, forests, hills, mountains
1 cities, savannahs, seas, plains
1 rainforests, cliffs, canyons, seas

Muunilinst 28
Shili NA
Kalee 23

Umbara NA
Tatooine 23
Jakku NA

temperate

temperate

arid, temperate, tropical

<NA>

arid

<NA>

surface_water population population_mils
0.25 5000000000

NA

NA

NA 4000000000

NA

NA

0.01 200000

NA
mass

NA

6990896123510658048 149571226

NA

NA

7041646564020810752 150657039

NA

NA

4020250749916094464 86013842

NA

13800
NA
13850
NA
10465
NA

NA
1
NA
au g radius
5000.0 1.0841006 9.8 6900.0
NA NA 9.8 NA
4000.0 1.0236055 9.8 6925.0
NA NA NA NA
0.2 0.8852253 9.8 5232.5
NA NA NA NA
area solar_system orig_tril
FALSE <NA>
FALSE <NA>
FALSE <NA>
FALSE <NA>
FALSE new_hope
FALSE <NA>

NA

terrain

<NA>
desert
deserts
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Go to file/function ~ Addins ~

Console Terminal Jobs

R R4.1.1 - ~/Desktop/psy611.../

R version 4.1.1 (2021-08-10) -- "Kick Things"
Copyright (C) 2021 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl7.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
"citation()"' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
"help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

Rl psy61l... ~
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Create a project

@ Network.quick.Rmd @] Network.Rmd | | reverse_key [ ] cor(data.net_us) datar» e=]

7] v A & Knit - Q- #Run ~ %~

65

66

67~ " {r} =

68 pty.net = estimateNetwork(data.pty, default = "ggmModSelect", stepwise = FALSE,
corMethod = "cor™)

69

70

71 gather(pty.net$graph)
72  pty.net$graph %>%

73 data.frame() %>%

74 rownames_to_column(var = "ITEMS") %>%
75 pivot_longer(cols = c(V1:V20),

76 names_to = "name",

77 values_to = "value") %>%
78 filter(value != @) %%

79 mutate(sum.weight = sum(value),

80 mean.weight = mean(value))

81

82 pty.net

83

84

85 plot(pty.net, title = "Personality IPIP data")
86

87 «cp.all = centralityPlot(pty.net, include = "all")
465 | [@ Chunk?2 = R Markdown =
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rId55.png
@ labl.Rmd =0

7 A @ knit - - Q- +Run ~ | %~
1l ---
2 title: "Labl"
3 author: "Vinita Vader"
4 date: "9/27/2021"
5 output: html_document
6‘ R
7
8~ # Section 1
9
10 I write simple text here.
11
12 This text is not evaluated (or run in R), but it **does** support formatting via markdown
syntax.
13
14~ " {r} =z
15 # your code goes here
16 1+ 2
174
18

19~ # Section ZI

19:12 Section 2 = R Markdown %
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"Lab_1"
"Cameron Kay"

9/22/2019"

output: html_document

# Section 1
simple text goes here

It is not evaluated, but it *xdoess

T {r}
# your code goes here
1+2

# Section 2

|

& Knit ~

|

Lab_1

Cameron Kay
9/22/2019

Section 1

Simple text goes here.

Itis not evaluated, but it does support formatting

# your code goes here
142

# [1] 3

Section 2
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10 + 5

## [1] 15
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10 - 5

## [1] 5
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10 * 5

## [1] 50




rId63.png
10 /5

## [1] 2
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10A5

## [1] 100000
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(10 + 5) * 2

## [1] 30
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10 + 5 * 2

## [1] 20
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my number <- 10
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my_ number

## [1] 10
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my number <- 20
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my_ number

## [1] 20
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my number + 5

## [1] 25
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my number <- my_number + 5

my_ number

## [1] 25
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rm(my_number)
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(10, 20, 20, 40, 50, 60)

## [1] 10 20 20 40 50 60
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my_vector <- c(10, 20, 20, 40, 50, 60)
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my_vector

## [1] 10 20 20 40 50 60
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my_vector[3]

## [1] 20
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my_vector[3] <- 30

my_vector

## [1] 10 20 30 40 50 60
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my_vector_2 <- ¢(1, 2, 3, 4, 5, 6)

my_vector + my_vector_2

## [1] 11 22 33 44 55 66
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my_vector_3 <- c(1000, 2000)

my_vector + my_vector_3

## [1] 1010 2020 1030 2040 1050 2060
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my_vector_4 <- c(1000, 2000, 3000, 4000)

my_vector + my_vector_4

## Warning in my_vector + my_vector_4: 1
onger object length is not a multiple
## of shorter object length

## [1] 1010 2020 3030 4040 1050 2060
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list(5L, 10, "fifteen", FALSE)

## [[11]
## [1] 5
##
## [[2]]
## [1] 10
##
## [[31]

## [1] "fifteen"
##
## [[4]]

## [1] FALSE
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mtcars[3, 10]

# [1] 4
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mtcars["Datsun 710", "gear"]

# [1] 4
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mtcars[, 10]

## [1] 44433334444333333444333334555554

mtcars[, "gear"]

## [1] 44433334444333333444333334555554




rId94.png
mtcars[3, ]

## mpg cyl disp hp drat wt gsec vs am gear carb
## Datsun 710 22.8 4 108 93 3.85 2.32 18.61 1 1 4 1

mtcars["Datsun 710", ]

## mpg cyl disp hp drat wt gsec vs am gear carb
## Datsun 710 22.8 4 108 93 3.85 2.32 18.61 1 1 4 1
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mtcars$gear

## [1] 44433334444333333444333334555554
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mtcars[c("Datsun 710", "Duster 360"), c("gear", "carb")]

#i#t gear carb
## Datsun 710 4 1
## Duster 360 3 4

mtcars[c(3, 7), c(10:11)]

#i#t gear carb
## Datsun 710 4 1
## Duster 360 3 4




rId98.png
length(c(l10, 20, 30, 40, 50, 60))

## [1] 6
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unique(c("cond_a", "cond_a", "cond_b", "cond_a", "cond_b"))

## [1] "cond_a" "cond_b"




